
 
Create a table 
When you create a database, you store your data in tables—subject-based lists that contain rows and columns. For 
instance, you can create a Contacts table to store a list of names, addresses, and telephone numbers, or a Products 
table to store information about products. 
This article explains how to create a table, how to add fields to a table, and how to set a table's primary key (primary 
key: One or more fields (columns) whose values uniquely identify each record in a table. A primary key cannot allow 
Null values and must always have a unique index. A primary key is used to relate a table to foreign keys in other 
tables.). It also explains how to set field and table properties. 
Because other database objects (database objects: An Access database contains objects such as tables, queries, 
forms, reports, pages, macros, and modules. An Access project contains objects such as forms, reports, pages, 
macros, and modules.) depend so heavily on tables, you should always start your design of a database by creating 
all of its tables and then creating any other objects. Before you create tables, carefully consider your requirements 
and determine all the tables that you need. For an introduction to planning and designing a database, see the article 
Database design basics. 
Note This article does not explain how to create a table by using a data-definition query (data-definition query: An 
SQL-specific query that contains data definition language (DDL) statements. These statements allow you to create or 
alter objects in the database.). Find links to more information about data-definition queries in the See Also section. 
In this article 
 

Overview 
A table is a database object that you use to store data about a particular subject, such as employees or products. A 
table consists of records and fields. 
Each record contains data about one instance of the table subject, such as a particular employee. A record is also 
commonly called a row or an instance. 
Each field contains data about one aspect of the table subject, such as first name or e-mail address. A field is also 
commonly called a column or an attribute. 
A record consists of field values, such as Contoso, Ltd. or someone@example.com. A field value is also commonly 
called a fact. 

 

A record 

A field 

A field value 

 
A database can contain many tables, each storing information about a different subject. Each table can contain many 
fields of different types of data, such as text, numbers, dates, and hyperlinks. 

 
Table and field properties 
Tables and fields also have properties that you can set to control their characteristics or behavior. 

 
A table open in Design view. 

Table properties 
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Field properties 
In an Access database, table properties are attributes of a table that affect the appearance or behavior of the table as 
a whole. Table properties are set in the table's property sheet, in Design view. For example, you can set a table's 
Default View property to specify how the table is displayed by default. 
A field property applies to a particular field in a table and defines one of the field's characteristics or an aspect of the 
field's behavior. You can set some field properties in Datasheet view (Datasheet view: A view that displays data from 
a table, form, query, view, or stored procedure in a row-and-column format. In Datasheet view, you can edit fields, 
add and delete data, and search for data.). You can also set any field property in Design view by using the Field 
Properties pane. 
Data types 
Every field has a data type. A field's data type indicates the kind of data that the field stores, such as large amounts of 
text or attached files. 

 
A data type is a field property, but it differs from other field properties as follows: 
You set a field's data type in the table design grid, not in the Field Properties pane. 
A field's data type determines what other properties the field has. 
You must set a field's data type when you create the field. 
 
Note: You can create a new field in Access by entering data in a new column in Datasheet view. When you create a 
field by entering data in Datasheet view, Access automatically assigns a data type for the field, based on the value 
that you enter. If no other data type is implied by your input, Access sets the data type to Text. If needed, you can 
change the data type by using the Ribbon, part of the new Microsoft Office Fluent user interface. 
Examples of automatic data type detection 
The following table shows how automatic data type detection works in Datasheet view. 

If you enter: Office Access 2007 creates a field 
with a data type of: 

John  Text 

http://www.contoso.com  
You can use any valid Internet protocol prefix. For example, http://, 
https://, and mailto: are valid prefixes. 

Hyperlink 

1 Number, Long Integer 

50,000 Number, Long Integer 

50,000.99 Number, Double 

50000.389 Number, Double 

12/67 
The date and time formats recognized are those of your user locale. 

Date/Time 

December 31, 2006 Date/Time 

10:50:23 Date/Time 

10:50 am Date/Time 

17:50 Date/Time 

$12.50 
The currency symbol recognized is that of your user locale. 

Currency 

21.75 Number, Double 

123.00% Number, Double 

3.46E+03 Number, Double 
 

 

Table relationships 
Although each table stores data about a different subject, tables in a database usually store data about subjects that 
are related to each other. For example, a database might contain: 
A customers table that lists your company’s customers and their addresses. 
A products table that lists the products that you sell, including prices and pictures for each item. 
An orders table that tracks customer orders. 
Because you store data about different subjects in separate tables, you need some way to tie the data together so 
that you can easily combine related data from those separate tables. To connect the data stored in different tables, 
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you create relationships. A relationship is a logical connection between two tables that specifies fields that the tables 
have in common. 
 

Keys 
Fields that are part of a table relationship are called keys. A key usually consists of one field, but may consist of more 
than one field. There are two kinds of keys: 
Primary key A table can have only one primary key. A primary key consists of one or more fields that uniquely identify 
each record that you store in the table. Often, there is a unique identification number, such as an ID number, a serial 
number, or a code, that serves as a primary key. For example, you might have a Customers table where each 
customer has a unique customer ID number. The customer ID field is the primary key of the Customers table. When a 
primary key contains more than one field, it is usually composed of pre-existing fields that, taken together, provide 
unique values. For example, you might use a combination of last name, first name, and birth date as the primary key 
for a table about people. 
Foreign key A table can also have one or more foreign keys. A foreign key contains values that correspond to values 
in the primary key of another table. For example, you might have an Orders table in which each order has a customer 
ID number that corresponds to a record in a Customers table. The customer ID field is a foreign key of the Orders 
table. 
The correspondence of values between key fields forms the basis of a table relationship. You use a table relationship 
to combine data from related tables. For example, suppose that you have a Customers table and an Orders table. In 
your Customers table, each record is identified by the primary key field, ID. 
To associate each order with a customer, you add a foreign key field to the Orders table that corresponds to the ID 
field of the Customers table, and then create a relationship between the two keys. When you add a record to the 
Orders table, you use a value for customer ID that comes from the Customers table. Whenever you want to view any 
information about an order's customer, you use the relationship to identify which data from the Customers table 
corresponds to which records in the Orders table. 

 
A table relationship, shown in the Relationships window. 

A primary key, identified by the key icon next to the field name. 

A foreign key — note the absence of the key icon. 
 
Benefits of using relationships 

Keeping data separated in related tables produces the following benefits: 
Consistency Because each item of data is recorded only once, in one table, there is less opportunity for ambiguity or 
inconsistency. For example, you store a customer's name only once, in a table about customers, rather than storing it 
repeatedly (and potentially inconsistently) in a table that contains order data. 
Efficiency Recording data in only one place means you use less disk space. Moreover, smaller tables tend to provide 
data more quickly than larger tables. Finally, if you don't use separate tables for separate subjects, you will introduce 
null values (the absence of data) and redundancy into your tables, both of which can waste space and impede 
performance. 
Comprehensibility The design of a database is easier to understand if the subjects are properly separated into tables. 



Tip Plan your tables with relationships in mind. You can use the Lookup Wizard to create a foreign key field if the 
table that contains the corresponding primary key already exists. The Lookup Wizard creates the relationship for you. 
 

Before you begin 
Before you start to create tables in Microsoft Office Access 2007, there are a few differences from earlier versions of 
Access that you should keep in mind. 
Table and field templates have replaced the Table Wizard In earlier versions of Access, you used the Table Wizard to 
create a table quickly by answering a few questions. In Office Access 2007, the Table Wizard has been replaced by 
table and field templates. 
Datasheet creation In Office Access 2007, you can create and modify tables and fields while working in Datasheet 
view. 
 

Create a new table 
A simple database, such as a contact list, might use only a single table. Many databases, however, use several 
tables. When you create a new database, you create a new file on your computer that acts as a container for all of 
the objects in your database, including your tables. 
Tip In Access 2010, you can use Application Parts to quickly add commonly used tables, forms, and reports to your 
database. Read an article or try Office 2010! 
You can create a table by creating a new database, by inserting a table into an existing database, or by importing or 
linking to a table from another data source — such as a Microsoft Office Excel workbook, a Microsoft Office Word 
document, a text file, or another database. When you create a new, blank database, a new, empty table is 
automatically inserted for you. You can then enter data in the table to start defining your fields. 
What do you want to do? 
 

Create a new table in a new database 
Click the Microsoft Office Button , and then click New. 
In the File Name box, type a file name for the new database. 
To browse to a different location to save the database, click the folder icon. 
Click Create. 
The new database opens, and a new table named Table1 is created and opens in Datasheet view. 
Create a new table in an existing database 
Click the Microsoft Office Button , and then click Open. 
In the Open dialog box, select the database that you want to open, and then click Open. 
On the Create tab, in the Tables group, click Table. 
A new table is inserted in the database and the table opens in Datasheet view. 
 

Use a table template to create a table 
In earlier versions of Access, you used the Table Wizard to quickly create a table from sample tables and fields. In 
Office Access 2007, you use table templates and field templates instead. 
A table template is an empty table that you can start using as-is, or modify to suit your needs. Office Access 2007 
comes with the following table templates, designed to be compatible with the Windows SharePoint Services 3.0 lists 
of the same name: 
Contacts A table for managing business contact information, which includes e-mail addresses, Web page URLs, and 
attachments, such as a service contract and a photo. 
Tasks A table for tracking tasks, which includes a field for attachments. 
Issues A table for tracking issues, which includes a field for attachments and an append-only Memo field that keeps a 
history of old field values. 
Events A table for managing events, which includes a rich text Memo field and a field for attachments. 
Assets A table for managing business assets, which includes two currency fields so that you can track asset 
depreciation. 
After you create a table by using a table template, you may want to add fields by using field templates. A field 
template is a predefined field that you can add to any table in Datasheet view. For more information about using a 
field template, see the section Add a field by using a field template, later in this article. 
 

Create a new table by using a table template 
Click the Microsoft Office Button , and then click Open. 
In the Open dialog box, select and open the database in which you wish to create a table. 
On the Create tab, in the Tables group, click Table Templates and then select one of the available templates from the 
list. 
A new table is inserted, based on the table template that you chose. 
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Import or link to create a table 
You can create a table by importing or linking to data that is stored elsewhere. You can import or link to data in an 
Excel worksheet, a Windows SharePoint Services list, an XML file, another Access database, a Microsoft Office 
Outlook folder, and more. 
When you import data, you create a copy of the data in a new table in the current database. Subsequent changes to 
the source data will have no effect on the imported data, and changes to the imported data do not affect the source 
data. After you connect to a data source and import its data, you can then use the imported data without connecting 
to the source. You can change the design of an imported table. 
When you link to data, you create a linked table in the current database that represents a live link to the existing 
information that is stored elsewhere. When you change data in a linked table, you are changing it in the source. 
Whenever data changes in the source, that change is shown in the linked table. You must be able to connect to the 
data source whenever you use a linked table. You cannot change the design of a linked table. 
Note You cannot edit data in an Excel worksheet by using a linked table. As a workaround, import the source data 
into an Access database, and then link to the database from Excel. For more information about linking to Access from 
Excel, search Excel Help, or see the links in the See Also section. 
Create a new table by importing or linking to external data 
Click the Microsoft Office Button , and then click Open. 
In the Open dialog box, select and open the database in which you wish to create a new table. 
On the External Data tab, in the Import group, click one of the available data sources. 
 
Follow the instructions in the dialog boxes that appear at each step. 
Access creates the new table and displays it in the Navigation Pane. 
Use a SharePoint site to create a table 

You can create a table in your database that imports from or links to a SharePoint list. You can also create a new 
SharePoint list by using a predefined template. The predefined templates in Office Access 2007 include Contacts, 
Tasks, Issues, and Events. 
Click the Microsoft Office Button , and then click Open. 
In the Open dialog box, select the database in which you want to create the new table, and then click Open. 
On the Create tab, in the Tables group, click SharePoint Lists. 
 
Do one of the following: 
Create a SharePoint list that is based on a template 
Click either Contacts, Tasks, Issues, or Events. 
In the Create New List dialog box, type the URL for the SharePoint site where you want to create the list. 
Enter a name for the new list and its description in the Specify a name for the new list and Description boxes. 
To open the linked table after it is created, select the Open the list when finished check box (selected by default). 
 

Create a new custom list 
Click Custom. 
In the Create New List dialog box, type the URL for the SharePoint site where you want to create the list. 
Enter a name for the new list and its description in the Specify a name for the new list and Description boxes. 
To open the linked table after it is created, select the Open the list when finished check box (selected by default). 

 
Import the data from an existing list 
Click Existing SharePoint List. 
In the Get External Data dialog box, type the URL for the SharePoint site that contains the data that you want to 
import. 
Click Import the source data into a new table in the current database, and then click Next.  
Select the check box next to each SharePoint list that you want to import. 

 
Link to an existing list 
Click Existing SharePoint List. 
In the Get External Data - SharePoint Site dialog box, type the URL for the SharePoint site that contains the list to 
which you want to link. 
Click Link to the data source by creating a linked table, and then click Next. 
Select the check box next to each SharePoint list to which you want to link. 
 

Set a table's primary key 
Unless you have a specific reason not to, you should specify a primary key for a table. Access automatically creates 
an index for the primary key, which can help improve database performance. Access also makes sure that every 



record has a value in the primary key field, and that the value is always unique. Unique values are crucial, because 
otherwise there is no way to reliably distinguish a particular row from other rows. 
When you create a new table in Datasheet view, Access automatically creates a primary key for you and assigns it a 
field name of ID and the AutoNumber data type. 
In Design view, you can change or remove the primary key, or set the primary key for a table that doesn't already 
have one. 
Determine which fields to use as a primary key 
Sometimes, you might already have data that you want to use as a primary key. For example, you may have existing 
ID numbers for your employees. If you create a table to track employee information, you might decide to use the 
existing employee ID as the primary key for the table. Or, perhaps employee ID is only unique in combination with 
department ID, requiring that you use both fields together as the primary key. A good candidate for the primary key 
has the following characteristics: 
Each record has a unique value for the field or combination of fields. 
The field or combination of fields is never empty or null — there is always a value. 
The values do not change. 
If no suitable data exists to use as a primary key, you can create a new field to use as a primary key. When you 
create a new field to use as a primary key, set the field's data type to AutoNumber to help make sure that it meets the 
three characteristics in the preceding list. 
Set or change the primary key 
Select the table whose primary key you want to set or change. 
On the Home tab, in the Views group, click View, and then click Design View. 
In the table design grid, select the field or fields that you want to use as the primary key. 
To select one field, click the row selector (row selector: A small box or bar that, when clicked, selects an entire row in 
table or macro Design view, or when you sort and group records in report Design view.) for the field that you want. 
To select more than one field, hold down CTRL, and then click the row selector for each field. 
On the Design tab, in the Tools group, click Primary Key. 
A key indicator appears to the left of the field or fields that you specify as the primary key. 

 
Remove the primary key 
Select the table whose primary key you want to remove. 
On the Home tab, in the Views group, click View, and then click Design View. 
Click the row selector (row selector: A small box or bar that, when clicked, selects an entire row in table or macro 
Design view, or when you sort and group records in report Design view.) for the current primary key. If the primary 
key consists of multiple fields, hold down CTRL, and then click the row selector for each field. 
On the Design tab, in the Tools group, click Primary Key. 
 
The key indicator is removed from the field or fields that you previously specified as the primary key. 
Note When you save a new table without setting a primary key, Access prompts you to create a new field for the 
primary key. If you click Yes, Access creates an ID field that uses the AutoNumber data type to provide a unique 
value for each record. If your table already includes an AutoNumber field, Access uses it as the primary key. If you 
click No, Access does not add a field, and no primary key is set. 
 

Set a table's properties 
In addition to setting properties fields, you can also set properties that apply to an entire table or to entire records.  
Select the table whose properties you want to set. 
On the Home tab, in the Views group, click View, and then click Design View. 
On the Design tab, in the Show/Hide group, click Property Sheet. 
 
The table property sheet is shown. 
On the property sheet, click the General tab. 
Click the box to the left of the property that you want to set, and then enter a setting for the property. 
Available table properties 

Use this table 
property 

To 

Display Views On 
SharePoint Site 

Specify whether views that are based on the table can be displayed on a SharePoint 
site.  
Note The effects of this setting depend on the setting of the Display All Views On 
SharePoint Site database property. 
For more information, see the See Also section. 

Subdatasheet Expanded Expand all subdatasheets when you open the table. 
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Subdatasheet Height Do one of the following: 
If you want the subdatasheet window to expand to display all rows, leave this 
property set at 0". 
If you want to control the height of the subdatasheet, enter the desired height in 
inches. 

Orientation Set the view orientation, according to whether your language is read left-to-right, or 
right-to-left. 

Description Provide a description of the table. This description will appear in tooltips for the 
table. 

Default View Set Datasheet, PivotTable, or PivotChart as the default view when you open the 
table. 

Validation Rule Enter an expression that must be true whenever you add or change a record. 
Validation Text Enter a message that is displayed when a record violates the expression in the 

Validation Rule property. 
Filter Define criteria to display only matching rows in Datasheet view. 
Order By Select one or more fields to specify the default sort order of rows in Datasheet view. 
Subdatasheet Name Specify whether a subdatasheet should appear in Datasheet view, and if so, which 

table or query should supply the rows in the subdatasheet. 
Link Child Fields List the fields in the table or query that are used for the subdatasheet that match the 

Link Master Fields property that is specified for the table.  
Link Master Fields List the fields in the table that match the Link Child Fields property that is specified 

for the table. 
Filter On Load Automatically apply the filter criteria in the Filter property (by setting to Yes) when 

the table is opened in Datasheet view. 
Order By On Load Automatically apply the sort criteria in the Order By property (by setting to Yes) 

when the table is opened in Datasheet view. 
 
Tip To provide more space to enter or edit a setting in the property box, press SHIFT+F2 to display the Zoom box. If 

you are setting the Validation Rule property to an expression and would like help in building it, click next to the 
ValidationRule property box to display the Expression Builder. 
To save your changes, press CTRL+S. 
 

Add a field to a table 
You store each piece of data that you want to track in a field. For example, in a contacts table you create fields for 
Last Name, First Name, Telephone Number, and Address. In a products table you create fields for Product Name, 
Product ID, and Price. 
Before you create fields, try to separate data into its smallest useful parts. It is much easier to combine data later than 
it is to pull it apart. For example, instead of a Full Name field, consider creating separate fields for Last Name and 
First Name. Then, you can easily search or sort by First Name, Last Name, or both. If you plan to report, sort, search, 
or calculate on an item of data, put that item in a field by itself. For more information about designing a database and 
creating fields, see the links in the See Also section. 
After you create a field, you can also set field properties to control its appearance and behavior. 
 

Add a field by entering data 
When you create a new table or open an existing table in Datasheet view, you can add a field to the table by entering 
data in the Add New Field column of the datasheet. 
 
Enter data in the Add New Field column. 
Create or open a table in Datasheet view. 
Note For more information about creating a table, see the section, Create a new table. 
In the Add New Field column, enter the name of the field that you want to create. 
Use a descriptive name so that the field will be easier to identify. 
Enter data in the new field. 
 

Add a field by using a field template 
Sometimes it is easier to choose from a predefined list of fields that fit your needs than to manually create a field. You 
can use the Field Templates task pane to choose from a list of field templates. A field template is a predefined set of 
characteristics and properties that describes a field. The field template definition includes a field name, a data type, a 
setting for the field's Format property, and other field properties. 
On the Home tab, in the Views group, click View, and then click Datasheet View. 
On the Datasheet tab, in the Fields & Columns group, click New Field. 
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Select one or more fields in the Field Templates pane, and then drag them to the table where you want to insert the 
new column. 
 

Add a field from an existing table 
If your database already contains tables, you can add a field from one of those tables to your new table by using the 
Field List pane. The Field List pane lists all the other tables in your database, grouped into two categories: Fields 
available in related tables and Fields available in other tables. If the table you are adding a field to is in relationships 
(relationship: An association that is established between common fields (columns) in two tables. A relationship can be 
one-to-one, one-to-many, or many-to-many.) with other tables, the related tables' fields are listed first in the Field List 
pane. 

 
Click the Microsoft Office Button , and then click Open. 
In the Open dialog box, select and open the database that you want to work with. 
In the Navigation Pane, double-click the table to which you want to add an existing field. 
The table opens in Datasheet view. 
On the Datasheet tab, in the Fields & Columns group, click Add Existing Fields. 
 
Click the plus sign (+) next to a table in the Field List pane to display the list of fields in that table. 
Select the field that you want, and drag it to the table where you want to insert the new column. 
Follow the instructions in the Lookup Wizard. 
After you have completed the wizard, the field appears in the table in Datasheet view. 
Note When you add a field from an unrelated table and then complete the Lookup Wizard, a new one-to-many 
relationship is automatically created between the table in the Field List pane and the table that you have open. 

 
Set field properties 
After you create a field, you can set field properties to control its appearance and behavior. 
For example, by setting field properties, you can: 
Control the appearance of data in a field 
Help prevent incorrect data entry in a field 
Specify default values for a field 
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Help speed up searching and sorting on a field 
You can set some of the available field properties while you work in Datasheet view. To have access to and set the 
complete list of field properties; however, you must use Design view. 
Set field properties in Datasheet view 
You can rename a field, change its data type, change its Format property, and change some of a field's other 
properties while you work in Datasheet view. 
Open a table in Datasheet view 
In the Navigation Pane, right-click the table that you want to open. 
On the shortcut menu, click Datasheet view. 

 
Rename a field 
When you add a field by entering data in Datasheet view, Access automatically assigns a generic name to the field. 
Access assigns the name Field1 to the first new field, Field2 to the second new field, and so on. By default, a field's 
name is used as its label wherever the field is displayed, such as a column heading on a datasheet. Renaming fields 
so that they have more descriptive names helps make them easier to use when you view or edit records. 
Right-click the heading of the field that you want to rename (for example, Field1). 
On the shortcut menu, click Rename Column. 
Enter the new name in the field heading. 
Field names can consist of up to 64 characters (letters or numbers), including spaces. 
Change a field's data type 
When you create a field by entering data in Datasheet view, Access examines that data to determine the appropriate 
data type for the field. For example, if you enter 1/1/2006, Access recognizes that data as a date and sets the data 
type for the field to Date/Time. If Access can't definitively determine the data type, the data type is set to Text by 
default. 
The data type of the field determines which other field properties you can set. For example, you can set only the 
Append Only property for a field that has the Hyperlink data type or the Memo data type. 
There may be cases where you want to manually change a field's data type. For example, suppose you have room 
numbers that resemble dates, such as 10/2001. If you enter 10/2001 into a new field in Datasheet view, the automatic 
data type detection feature selects the Date/Time data type for the field. Because room numbers are labels, and not 
dates, they should use the Text data type. Use the following procedure to change a field's data type. 
On the Ribbon, click the Datasheet tab . 
In the Data Type list, in the Data Type & Formatting group, select the data type that you want. 
 
Available data types 

Data type Use to store Size 

Text Alphanumeric characters  
Use for text, or for numbers that are not used in calculations 
(for example, a product ID). A numeric value that is stored 
as text can be sorted and filtered more logically, but cannot 
be easily used in calculations. 

Up to 255 characters. 

Memo Alphanumeric characters (longer than 255 characters in 
length) or text that uses rich text formatting. 
Use for text that is more than 255 characters in length, or for 
text that uses rich text formatting. Notes, lengthy 
descriptions, and paragraphs that use text formatting, such 
as bold or italics, are good examples of where to use a 
Memo field. 

Up to 1 gigabyte of characters, or 2 gigabytes 
of storage (2 bytes per character), of which 
you can display 65,535 characters in a 
control. 

Number Numeric values (integers or fractional values). 
Use for storing numbers that are used in calculations, 
except for monetary values (use the Currency data type for 
monetary values). 

1, 2, 4, or 8 bytes, or 16 bytes when used for 
a replication ID. 

Date/Time Dates and times. 
Use for storing date/time values. Note that each value 
stored includes both a date component and a time 
component.  

8 bytes. 

Currency Monetary values. 
Use for storing monetary values (currency). 

8 bytes. 

AutoNumber A unique numeric value that Access automatically inserts 
when a record is added. 
Use for generating unique values that can be used as a 
primary key. Note that values for AutoNumber fields can be 

4 bytes or 16 bytes when used for replication 
ID. 
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incremented sequentially or by a specified value, or 
assigned randomly. 

Yes/No Boolean values (yes/no). 
You can use one of three formats: Yes/No, True/False, or 
On/Off. 

1 bit (8 bits = 1 byte). 

OLE Object OLE objects or other binary data. 
Use for storing OLE objects from other Microsoft Windows 
programs. 

Up to 1 gigabyte.  

Attachment Pictures, Images, Binary files, Office files. 
This is the preferred data type for storing digital images and 
any type of binary file. 

For compressed attachments, 2 gigabytes. 
For uncompressed attachments, 
approximately 700kb, depending on the 
degree to which the attachment can be 
compressed.  

Hyperlink Hyperlinks. 
Use for storing hyperlinks to provide single-click access to 
Web pages through a URL (Uniform Resource Locator) or 
files through a name in UNC (universal naming convention) 
format. You can also link to Access objects stored in a 
database. 

Up to 1 gigabyte of characters, or 2 gigabytes 
of storage (2 bytes per character), of which 
you can display 65,535 characters in a 
control. 

Lookup 
Wizard 

Not actually a data type; instead, this starts the Lookup 
Wizard. 
Use to start the Lookup Wizard so that you can create a field 
that uses a combo box to look up a value in another table, 
query, or list of values. 

Table or query based: The size of the bound 
column. 
Value based: The size of the Text field used to 
store the value. 

Note The maximum size of an Access database file is 2 gigabytes. 
Tips on data types 
To optimize performance, you should use the most appropriate Field Size when you create a Text or Number field. 
For example, if you expect to store postal codes of a predictable length, specify that length as the field size. You can 
specify the field size by setting a value in the FieldSize property box. For more information, see the section, Set other 
field properties. 
For phone numbers, part numbers, and other numbers that you don't intend to use for mathematical calculations, you 
should select the Text data type instead of the Number data type. A numeric value that is stored as text can be sorted 
and filtered more logically. 
 

Change a field's format 
In addition to determining the data type of a new field, Access may also set the Format property for the field, 
depending on what you enter. For example, if you enter 10:50 a.m., Access sets the data type to Date/Time and the 
Format property to Medium Time. To manually change a field's Format property, do the following: 
On the Ribbon, click the Datasheet tab. 
In the Format list, in the Data Type & Formatting group, enter the format that you want. 
Note the Format list may be unavailable for some fields (for example, Text), depending on the data type of the field. 
 

Set other field properties 
In Datasheet view, click the field for which you want to set the property. 
On the Datasheet tab, in the Data Type & Formatting group, select the properties that you want. 
 
Set field properties in Design view 
You can set any field property while you work with a table in Design view. In Design view, you set a field's data type 
in the table design grid, and you set other properties in the Field Properties pane. 
Open a table in Design view 
In the Navigation Pane, right-click the table. 
On the shortcut menu, click Design view. 
Change a field's data type 
In the table design grid, locate the field for which you want to set the data type. 
In the Data Type column, choose a data type from the list. 

Available data types 

Data type Use to store Size 

Text Alphanumeric characters  
Use for text, or for numbers that are not used in calculations 
(for example, a product ID). A numeric value that is stored 
as text can be sorted and filtered more logically, but cannot 

Up to 255 characters. 
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be easily used in calculations. 
Memo Alphanumeric characters (longer than 255 characters in 

length) or text that uses rich text formatting. 
Use for text that is more than 255 characters in length, or for 
text that uses rich text formatting. Notes, lengthy 
descriptions, and paragraphs that use text formatting, such 
as bold or italics, are good examples of where to use a 
Memo field. 

Up to 1 gigabyte of characters, or 2 gigabytes 
of storage (2 bytes per character), of which 
you can display 65,535 characters in a 
control. 

Number Numeric values (integers or fractional values). 
Use for storing numbers that are used in calculations, 
except for monetary values (use the Currency data type for 
monetary values). 

1, 2, 4, or 8 bytes, or 16 bytes when used for 
a replication ID. 

Date/Time Dates and times. 
Use for storing date/time values. Note that each value 
stored includes both a date component and a time 
component.  

8 bytes. 

Currency Monetary values. 
Use for storing monetary values (currency). 

8 bytes. 

AutoNumber A unique numeric value that Access automatically inserts 
when a record is added. 
Use for generating unique values that can be used as a 
primary key. Note that values for AutoNumber fields can be 
incremented sequentially or by a specified value, or 
assigned randomly. 

4 bytes or 16 bytes when used for replication 
ID. 

Yes/No Boolean values (yes/no). 
You can use one of three formats: Yes/No, True/False, or 
On/Off. 

1 bit (8 bits = 1 byte). 

OLE Object OLE objects or other binary data. 
Use for storing OLE objects from other Microsoft Windows 
programs. 

Up to 1 gigabyte.  

Attachment Pictures, Images, Binary files, Office files. 
This is the preferred data type for storing digital images and 
any type of binary file. 

For compressed attachments, 2 gigabytes. 
For uncompressed attachments, 
approximately 700kb, depending on the 
degree to which the attachment can be 
compressed.  

Hyperlink Hyperlinks. 
Use for storing hyperlinks to provide single-click access to 
Web pages through a URL (Uniform Resource Locator) or 
files through a name in UNC (universal naming convention) 
format. You can also link to Access objects stored in a 
database. 

Up to 1 gigabyte of characters, or 2 gigabytes 
of storage (2 bytes per character), of which 
you can display 65,535 characters in a 
control. 

Lookup 
Wizard 

Not actually a data type; instead, this starts the Lookup 
Wizard. 
Use to start the Lookup Wizard so that you can create a field 
that uses a combo box to look up a value in another table, 
query, or list of values. 

Table or query based: The size of the bound 
column. 
Value based: The size of the Text field used to 
store the value. 

Note The maximum size of an Access database file is 2 gigabytes. 
Tips on data types 
For phone numbers, part numbers, and other numbers that you don't intend to use for mathematical calculations, you 
should select the Text data type instead of the Number data type. A numeric value that is stored as text can be sorted 
and filtered more logically, but cannot be easily used in calculations. 
For the Text and Number data types, you can specify the field size or data type more precisely by setting a value in 
the FieldSize property box. 
 

Set other field properties 
In the table design grid, select the field for which you want to set properties. Access displays the properties for this 
field in the Field Properties pane. 
Note The data type of the field determines the properties that you can set. 
In the Field Properties pane, enter the settings that you want for each property, or press F6 and then use the arrow 
keys to select a property. 
Note Not all properties are available for every field. A field's data type determines which properties it has. 



Field 
property 

Description 

Field Size Set the maximum size for data stored as a Text, Number, or AutoNumber data type. 
Tip For best performance, always specify the smallest sufficient Field Size. 

Format Customize the way that the field appears by default when displayed or printed. 
Decimal Places Specify the number of decimal places to use when displaying numbers. 
New Values Specify whether an AutoNumber field is incremented or assigned a random value when a new record is 

added. 
Input Mask Display characters that help to guide data entry. For more information about creating and using an input 

mask, see the See Also section. 
Caption Set the text displayed by default in labels for forms, reports, and queries.  
Default Value Automatically assign a default value to a field when new records are added. 
Validation Rule Supply an expression that must be true whenever you add or change the value in this field. 
Validation Text Enter a message to display when a value violates the expression in the Validation Rule property. 
Required Require that data be entered in a field. 
Allow Zero 
Length 

Allow entry (by setting the property's value to Yes) of a zero-length string ("") in a Text or Memo field. 

Indexed Speed up access to data in this field by creating and using an index. 
Unicode 
Compression 

Compress text stored in this field when a small amount of text is stored (< 4,096 characters). 

IME Mode Control conversion of characters in an East Asian version of Windows. 
IME Sentence 
Mode 

Control conversion of sentences in an East Asian version of Windows. 

Smart Tags Attach a smart tag (action tags: Data recognized and labeled as a particular type. For example, a 
person's name or the name of a recent Microsoft Outlook e-mail message recipient is a type of data that 
can be recognized and labeled with an action tag.) to this field.  

Append Only Track the history of field values (by setting the property's value to Yes).  
Text Format Choose the property's Rich Text value to store text as HTML and allow rich formatting. Choose the 

property's Plain Text value to store only unformatted text. 
Text Align Specify the default alignment of text within a control. 
To provide more space for entering or editing a property setting in the property box, press SHIFT+F2 to display the 
Zoom box. 

Tip If you are entering an input mask or validation expression and would like help in building it, click next to the 
property box to display the appropriate builder. 
To save your changes, press CTRL+S. 
 

Save a table 
After you create or modify a table, you should save its design. When you save a table for the first time, give it a name 
that describes the data that it contains. You can use up to 64 alphanumeric characters, including spaces. For 
example, you might name a table Customers, Parts Inventory, or Products. 
Tip You should decide on a naming convention for the objects in your database, and use it consistently. 
Click the Microsoft Office Button , and then click Save, or press CTRL+S . 

If you are saving the table for the first time, type a name for the table, and then click OK. 
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